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Microsoft Word: Is a word processing program. In other words, it is simply 

a program written to help you create reports and projects. 

 You can use M.Word to do so many things: 

1-Letters  

2- Flyers  

3- Forms  

4- Reports  

5- Envelopes and Labels 

- Microsoft Word can be accessed through the desktop or through  the 

Start menu (located on the taskbar at the bottom of the screen). 

 

THE WORD SCREEN 

After you start the program, you are taken into a blank untitled document 

where you may begin entering your text.  
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1. Quick Access toolbar (can be above or below the ribbon)  

2. File tab (blue in Word, green in Excel, dark orange in 

PowerPoint)  

3. Home ribbon (the Home tab is selected)  

4. Dialog box launcher button  

5. View Ruler (on/off) button  

6. Help button  

7. Text area                                         

8. Vertical Scroll bar 

9. Horizontal Scroll bar 
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10. Status bar 

11. Insertion Point (cursor) 

12. Zoom 

The Microsoft Word 2019 screen is made up of different levels of 

organization.  

File Tab:  

 

 

 

 

Tabs: 

 

 

 

 

 

Groups: Within each tab, you will see groups. Items within a group perform 

a related function. 
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Dialog Box Launcher Buttons: Groups often display a Dialog Box Launcher 

at the bottom-right of the group. Clicking this will display a dialog box 

displaying additional options.  

 

 

 

 

 

Title Bar: Next to the Quick Access toolbar is the Title bar. The Title bar 

displays the title of the document on which you are currently working. 

 

Insertion Point (cursor): The flashing vertical line that indicates where the 

text will appear when you type. 

Quick Access Toolbar: 

 

The Quick Access toolbar provides you with access to commands you 

frequently use. By default Save, Undo, and Redo appear on the Quick Access 
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toolbar. 

To add a command to the Quick Access toolbar: 

If you click the drop down arrow to the right of the Quick Access toolbar, it 

will display the Customize Quick Access Toolbar menu. You can add tools on 

the list by clicking to the left of the item to enable it. Enabled items are 

checked.  

➢ To add more commands, select the More Commands link and look 

for the commands you would like.  

➢ To move the Quick Access toolbar below the ribbon, select Show 

below the Ribbon.  

 

 

 

 

 

 

The Ribbon: When you first start Microsoft Word, you normally see the 
Home tab displayed, as illustrated. This tab contains icons and other 
controls that are most commonly used within Microsoft Word. 
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You can reduce the size of the Ribbon by clicking on the Minimize the Ribbon 
control (located towards the top-right of your screen):  
 
 
 
To restore the Ribbon, simply re-click on the Minimize the Ribbon control 
once more. 

 

Status Bar: The bar at the bottom of the screen that shows information 

about the page, section, and location of the insertion point. 

 

 

- On the right side of the Word Status Bar are the View buttons and the 

Zoom control slider.  

Zoom: Allows you to change the size of the display.  

Note: this only affects what you see on the screen, not the way the page 

will print. 

Ruler Bar: The bar at the top and side of the page that shows the margin 

and tab settings.  

 

- If your ruler is not visible, follow the steps listed here: 
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1- Click the View tab to choose it. 

2- Click the check box next to Ruler in the Show/Hide group. The ruler 

appears below the Ribbon. 

 

The Horizontal and Vertical Scroll Bars 

The vertical and horizontal scroll bars enable you to move up, 

down, and across your window simply by dragging the icon 

located on the scroll bar. 

- Microsoft Office Word allows you to create and edit personal and 

business documents, such as letters, reports, invoices, emails and 

books. 

  By default, documents saved in Word 2019 are saved with the .docx 

extension. 

Document: The page or pages on which you will type your information. 

New: Create a new document.  

            To begin a new document: 

1. Click the File tab and then click New.  

2. Under Available Templates, click Blank Document.  



INTRODUCTION TO MICROSOFT WORD 
 

  8  

 

3. Click Create.  

 

Open: Open an existing document.  

Close: Close a document that you have already opened. 
 

Create Sample Data and Select Text: 

To create sample data:  

1. Type =rand ( ) then  

       2. Press Enter. Three paragraphs appear in your document. 

Selecting text between two points 

Click at the start of the block of text, hold down Shift, and click at the end 

of the block. 

Selecting a single word 

Simply double click anywhere on the word you want to select. 

 

1 

2 
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Selecting a paragraph 

Simply triple click anywhere on the paragraph you want to select. 

Selecting a sentence 

Hold down Ctrl key and click anywhere in the sentence you want to select. 

Select All 

Press Ctrl + A keys to select the entire document. 

 

Insert and Replace Text: 

In this insertion mode, text will be added into the existing content but 

same time it will over write all the content which comes in its way. 

Saving a Document 

Save: Save the document that you created or have worked on.  

Home Tab  
 
Setting Text Fonts and Size in Word 2019 

Microsoft word allows you to use different fonts with different size. You can 

change your document's appearance by changing the fonts and their size. 

 Change the Font Type & Size: 
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Here is a screen capture to show you few font related buttons. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Copy and Paste Operation: 

Copy (Ctrl + c): Copy operation will just copy the content from its original 

place and create a duplicate copy of the content at the desired location 

without deleting the text from it is the original location. 

Cut and Paste Operation: 

Cut (Ctrl + c): Cut operation will cut the content from its original place and 

move the content from its original location to a new desired location.  

Note: You can repeat paste operation as many times as you like to paste the 
same content. 

Undo and Redo the Changes in Word 2019 

Microsoft word provides two important features called: 
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Undo (Ctrl + Z): Is used to undo the previous action. 

Repeat or Redo (Ctrl + Y): Which is used to repeat the previous action. 

Change Paragraph Alignment: 
  

The paragraph alignment allows you to set how you want text to appear.  

 

 

 

 

 

Delete Text in Microsoft word :  

Using Backspace & Delete Keys: 

The most basic deletion technique is to delete characters one at a time by 

pressing either backspace or delete keys.  

1-Backspace: Keep the insertion point just after the character you want to 

delete and press backspace key. Word deletes the character immediately to 

the left of the insertion point. 

2- Ctrl + Backspace: Keep the insertion point just after the word you want 

to delete and press Ctrl + Backspace key. Word deletes the whole word 

immediately to the left of the insertion point. 
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3-Delete: Keep the insertion point just before the character you want to 

delete and press delete key. Word deletes the character immediately to the 

right of the insertion point. 

4-Ctrl + Delete: Keep the insertion point just before the word you want to 

delete and press Ctrl + Delete key. Word deletes the word immediately to 

the right of the insertion point. 

Find & Replace in Word 2019 

Find Command (Ctrl + F): The Find command enables you to locate 

specific text in your document.  

Replace Operation(Ctrl + H):Allows you to change specific data to 

something else.  

Bullets or Numbering:  

You can quickly add bullets or numbers to existing lines of text, or Word can 

automatically create lists as you type. 

Format Painter: The Format Painter feature allows you to quickly copy a 

format that you have applied to text already in your document. 

1. Select the text or graphic that has the formatting that you want to copy.  

2. On the Home tab, in the Clipboard group, single click Format Painter. 

The pointer will change to a paintbrush icon.  

3. Bring your cursor to the text or graphic that you want to format and click 
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on the text.  

4. To stop formatting, press ESC or click on the Format Painter command 

again.  

 

➢ NOTE: Double-click the Format Painter button if you want to change 

the format of multiple selections in your document. 

Clearing Formats :You can use the Clear Formatting command to remove 

all formatting and styles from selected text, leaving only the plain text. 

Line Spacing: The Spacing feature allows you to change the spacing 

between paragraphs by adding line space above or below the selected 

paragraphs. 

Superscript: Refers to characters displayed above the normal line.  

Subscript: Refers to text displayed below the normal line of text.  

Change Case: Allows you to change the selected text to all uppercase, all 

lowercase, normal sentence case, or toggle case. 

Assign a Password: If you have a Word file containing confidential 

information that you need to share with someone else, you should 

password protect the file. 

Print Preview: You can preview your printing during the printing process to 

ensure appropriate page layout. 
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Insert Tab - Inserting Objects 

 

This tab can be used to insert various types of objects, including pages, 

tables, illustrations, links, headers & footers, text, and symbols. 

Headers and Footers: Headers and footers are areas containing text that 

will be displayed on every page.  

     - The header is located along the top of every page; the footer is 

located at the bottom of every page.  

         - Headers and footers enhance the professional appearance of your 

document and may include page numbers, chapter titles, logos, dates, and 

other information about your document. 

Page Numbers:  Page numbers help you keep your document organized 

and enable readers to find information quickly.  

- You can add page numbers to the top, bottom, or margins of your 

pages and you can choose where the numbers appear.  

Symbols and Equations 

Symbols: Symbols that are not found on a normal keyboard can be added to 

Microsoft Word documents by selecting Symbol from the Symbols group. A 

list of commonly used symbols will display. Click on one of the symbols in 

the list or click More Symbols to pick from a larger list. 
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Equations: Equations can be added to a Microsoft Word document by 

selecting Equation from the Symbols group and then selecting from the list 

of pre-defined equations or clicking Insert New Equation and entering your 

own equation. 

Table: A Table consists of rows and columns that intersect to form boxes 

called cells. You can insert text or graphics into cells. 

Draw Table: Used to “draw” a table using the mouse. 

Insert Table: Insert Table lets you determine the table size by the number 

of columns and rows, as well as the column widths. Just use the dialog box 

to enter the dimensions for the desired table size. 

 

 

Changing Cell Size:  

There are several ways to change the size of rows and columns in a table, 

both by setting the dimensions and by dragging the cell borders. 

Table Options: 

The Tables group includes several options to insert a table, which include: 

draw a table, convert text to table, choose from various Quick Table options, 

and insert an Excel spreadsheet 
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Convert Text to a Table: 

The Convert Text to a Table option allows you to convert existing text to a 

table 

  

Page Breaks: Instead of pressing the Enter Key several times until you 

create a new page, the Page Break option allows you to select a specific 

point on the page and manually insert a new page, a blank page, or choose 

from several styles to create a cover page. 

Inserting Text Boxes:  A text box is an object that lets you put and type text 

anywhere in your file. 

 

 

 

Flowing Text between Text Boxes  

The following explains how to allow text to flow between text boxes.  

1. Double-click the border of the first text box to display the Text Box Tools 

in the Ribbon.  

2. Delete any text in the second text box (You can only flow text into an 

empty text box).  
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3. In the Text group, click Create Link.  

Links: Links to websites or other locations within a Word document can be 

created by using the Links group.  

 

WordArt: WordArt are text objects that use a gallery of text styles to create 

decorative effects such as shadowed or mirrored (reflected). You can 

customize the shape surrounding the WordArt as well as the text in the 

WordArt.  

- For example, you can change the text style and fill it with color, make it 

transparent, or add a beveled edge effect. Again, this feature is designed 

to enhance not encumber the purpose of your document. 

Insert Picture/Clip Art  

Pictures and clip art can be inserted or copied into a document from many 

different sources, including downloaded from a clip art Web site provider, 

copied from a Web page, or inserted from a folder where you save pictures. 

Text Wrapping: Sometimes you may need to have text flow around a 

picture; this is called “text wrapping”.  

Screenshot: Whether creating a template or another document, it can be 

helpful to add a screenshot to your document. A screenshot is a picture of 

any computer window, like Internet Explorer, or a clipping of any portion of 
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your screen, like a small part of the desktop.  

Insert Charts: Charts are used to display data in an easy-to-read graphical 

format. Charts make it easier to understand large quantities of data and the 

relationship or trends among different series of data. 

SmartArt Graphic:  A SmartArt graphic is a visual representation of your 

information that you can quickly and easily create, choosing from among 

many different layouts 

  Insert text from File: Allows you to insert the contents of a file into the 

document.  

Page Layout Tab - Document Layout 

 

This tab contains commands that affect the overall appearance of a 

document. 

Page Setup: The Page Setup group contains the options to specify the 

layout of a page, such as margins, orientation, and page size. 

Margins: The white space between the edge of the document page and 

the document text is known as the margin.  

  -The normal margins in Word are one inch for all margins: top, bottom, 

left, and right. Margins automatically define where one page breaks and 

the next begins.  
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Page Orientation : You can choose either portrait (vertical) or landscape 

(horizontal) orientation for all or part of your document. 

Page Background : To include a watermark on the page, such as 

‘Confidential’ or ‘Draft’, select Watermark from the Page Background 

group and then select one of the pre-defined watermarks or Custom 

Watermark to specify the text you would like to see appear as a 

watermark on the page. 

         -To set a page color, click Page Color and select a color from the list of 

Theme Colors or click More Colors to pick a color not available from the list. 

Borders and Shading: Provides options for adjusting the border, style, 

color, width, shading, and location of a border or shading.  

     - Microsoft Word allows you to place a border on any or all of the four 

sides of selected text, paragraphs, and pages.  

    - You can also add many type of shading to the space occupied by selected 

text, paragraphs, and pages.  

To add a border to the page, click Page Borders to bring up the Borders and 

Shading window.   From here, you can specify how you want your border to 

appear, including style, color, width, and pictures. 

Columns: Allows you to insert columns into the existing document. 

Column Breaks: Column breaks mark the point at which one column ends 

and another begins. The default setting for displaying text in a document is 

one column. When you set up multiple columns, the column break feature 
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allows you to control the bottom margin of each column. 

Insert a Column Break 

1. Page Layout Tab > Page Setup group > Columns, and then select the 

appropriate number of columns.  

2. Place the insertion point where the new column should begin.  

3. Page Layout Tab > Page Setup group > Breaks > Page Breaks > Column.  

AutoCorrect: Allows you to set up the program so that your common errors 

are automatically corrected as you type. 

AutoText:  Provides you with the option of inserting selected text.  

Indentation 

Left Indentation: Left indentation means to move the left edge of the 

paragraph inward towards the center of the paragraph.  

First Line Indentation: Moves the left side of the first line of a paragraph 

inward toward the center. 

Hanging Indentation: Moves the left side of the first line of a paragraph 

leftward, away from the center which is called hanging indentation.  

References Tab: 

This tab contains commands related to items that you can add to a 
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document 

Footnotes & Endnotes : 

Used for comments and citations at the bottom of a page or document.  

- Inserting a footnote will put the note at the bottom of the current page 

while an endnote will be placed at the end of the document.  

 

➢ To insert a footnote, place your cursor at the end of a sentence and click 

Insert Footnote from the Footnotes group. A superscript number will 

appear at the end of the sentence and the corresponding number will 

appear at the bottom of the page in which you can place your comment or 

citation.  

➢ Insert an endnote by placing your cursor at the end of a sentence and 

click Insert Endnote. The corresponding number will appear on the last 

page of your document. 

To change the styling of footnotes and endnotes, click on the Show Footnote 

and Endnote  Dialog Box launcher. 
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Spell and Grammar Check in Word 2019 

Microsoft Word provides a Spelling and Grammar Checker which enables 

you to search for and correct all spelling and grammar mistakes in your 

document. 

Grammar errors and underlines them as follows. 

➢ A red underline beneath spelling errors. 

➢ A green underline beneath grammar errors. 

➢ A blue line under correctly spelled but misused words. 

Now you have following options to fix the spelling mistake: 

✓ Ignore: If you are willing to ignore a word then click this button and 

word ignores the word throughout the document. 

✓ Ignore All: Like Ignore, but ignores all occurrences of the same 

misspelling, not just this one. 

✓ Add to Dictionary: Choose Add to Dictionary to add the word to the 

Word spelling dictionary. 

✓ Change: This will change the wrong word using the suggested correct 

word. 

✓ Change All: Like Change, but change all occurrences of the same 

misspelling, not just this one. 

✓ AutoCorrect: If you select a suggestion, Word creates an AutoCorrect 
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entry that automatically corrects this spelling error from now on. 

Show/Hide: The Show/Hide group allows different components of Word to 

be displayed, including the ruler, gridlines, and document map. 

Document Views  

In Word 2019, you can display your document in one of five views: Draft, 

Web Layout, Print Layout, Full Screen Reading, or Online Layout.  

Draft View: Draft view shows text formatting but simplifies the layout of 

the page so that you can type and edit quickly.  

- In draft view, some page elements do not appear, such as the boundaries 

between pages, headers and footers, backgrounds, and pictures that do 

not have text wrapping style set to In Line with Text. 

Web Layout: Web Layout view enables you to see your document as it 

would appear in a browser such as Internet Explorer.  

Print Layout: Use print layout view to see the document as it appears on 

the printed page. Print layout view is the default view when you open a new 

document. 

Full Screen Reading Layout: The document will be displayed in a page size 

and the scroll bars will not be displayed also two pages of the document 

will be displayed at the same time. 
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Outline View: Use outline view to create an outline and manipulate text 

easily. Move text up and down, expand and collapse levels, change heading 

levels, or show only one kind of heading level. 

 

Word Options: The Word Options, found in the File tab,  Allows you to 

adjust the way that the Word program works for you. 

Window: If you are working with multiple Word documents, you can switch 

between them by clicking the Switch Windows icon under the Window 

group or set them to be viewed side by side with the View Side by Side icon 

under the Window group. 

 

Arrange All: Allows you to view more than one document on the screen at 

the same time. 

Split: Allows you to view different parts of a document at the same time.  

DROP CAP: A drop cap is a large capital letter at the beginning of a text 

block that has the depth of two or more lines of regular text.  

The following illustration shows your options for positioning a drop cap. 

 Dropped 

 In margin 


